
CHAPTER

In This Chapter
•	 Audio
•	 Closed Captioning
•	 Video
•	 Web Objects 
•	 Flash

Introduction
You’ve already learned how to add text and graphics. Now it’s time to learn how to add 
other forms of media:

•	 Audio: Import or record sound such as narration, music, or sound effects.
•	 Video: Import or record video files, or embed them from popular video sharing 

sites such as YouTube and Vimeo.
•	 Flash: Import Flash animations or movies.
•	 Web objects: Insert live web pages that your students can interact with right in 

the course. 

Working  
With Media 8
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To import audio to a slide:
1.	 Go to the Insert tab.
2.	 Click the Audio drop-down button.
3.	 Select Audio from File.
4.	 Find and select the file you want.
5.	 Click the Open button.

Import Audio to a Slide

Working With Audio
You can add audio to your course by importing an audio file you already 
have, recording it directly in Storyline, or generating narration using the 
text-to-speech feature. 

Audio File Types

   .aac        .aif
   .aiff        .m4a
   .mp3      .ogg
   .wav      .wmaPOWER TIP

When you record or import audio, it is converted to .mp3 format 
at 192 kbps (kilobits per second). When you publish your project, 
you can adjust the quality to help manage file size.

Publish Settings, p. 259

BRIGHT IDEAS
•	 If you import a PowerPoint slide with audio 

recorded in PowerPoint or Articulate Presenter, the 
audio is imported and works like any other audio. 
If the audio was attached as a file in PowerPoint, it 
will not be imported. 

•	 If you import an Engage file that contains audio, 
that audio plays in Storyline as well; however, like 
the rest of the Engage interaction, it cannot be 
edited in Storyline.

Import a Slide, p. 31
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To record audio in Storyline:
1.	 Go to the Insert tab.
2.	 Click the Audio drop-down button.
3.	 Select Record Mic.
4.	 Click the Record button. (A)
5.	 Speak into your microphone.
6.	 Click the Stop button. (B)
7.	 Click the Save button.

You have the following options before and after recording:
•	 Narration script: Click this button to bring up any 

text you have in the Notes panel for that slide. 

Slide Notes, p. 43

•	 Import audio file: This button works the same as the 
procedure on the previous page. If you have already 
recorded audio here, importing a new file will replace 
what you just recorded.

You have the following options after recording:
•	 Record: Click this button to re-record the audio over 

what you just recorded.
•	 Play/Pause/Rewind: Use these buttons to listen to 

what you’ve recorded.
•	 Delete: Click this button to delete the audio on the 

slide. 
•	 Edit audio: Click this button to go to the audio editor, 

which you’ll learn about on page 106.

Record Audio in Storyline

Re
co

rd
/S

to
p

Re
w

in
d

Pl
ay

/P
au

se
De

le
te

Ed
it 

au
di

o
Na

rra
tio

n 
sc

rip
t

Im
po

rt 
au

di
o 

fil
e

CAUTION
When you click the Record button, the 
recording doesn’t actually start for two 
seconds. Watch for the text prompts so that 
you don’t start talking before the recording 
truly starts.

A
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Rather than have a live human record your audio, 
you can add system-generated audio. With just a 
few clicks, you can take your text and turn it into 
a recording. 

To convert text to speech:
1.	 Go to the Insert tab.
2.	 Click the Audio drop-down button.
3.	 Select Text-to-Speech.
4.	 Enter the text you want to convert to audio.
5.	 Select your options. (See below.)
6.	 Click the Insert button. 

TIME SAVER
If you have your narration text in 
the Slide Notes panel, you can just 
click the Copy from slide notes 
button to paste that text here.

Slide notes, p. 43

Additional Options:
Select a Language (A)
Use this menu to select the language of your script to help 
with the proper pronunciation. In some cases, you can pick 
between different accents, such as the accent from Canada 
or France for the French language. 
Note: This feature does not translate your script into another 
language. Selecting the language simply tells Storyline what 
phonetic rules to use when generating the speech.

Select a Voice (B)
Use this menu to select a voice to use for your script. There 
are several to choose from, both male and female. Click the 
Preview Voice button to find out what it will sound like.

Generate Closed Captions (C)
Select this option to automatically generate closed captions 
based on your script.

Closed captions, p. 109

Converting Text to Speech

CBA
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Editing Text-to-Speech
To edit existing text-to-speech:

1.	 Select the audio file in the timeline.
2.	 Go to the Options tab.
3.	 Click the Text-to-Speech button.
4.	 Make your changes.
5.	 Click the Update button.

BRIGHT IDEA
The generated voice will sound a little bit robotic, 
and some students might not like it. However, 
the generated version can be great during review 
cycles while you are still making changes. Then 
you can swap the audio with the professional 
recording at the end. 
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When you import or record audio on your slide, it appears 
at the playhead in the timeline. (B) If you want to change 
the starting point of the audio, simply click and drag the 
audio item left (earlier) or right (later) in the timeline.

Adjust Timing of Audio

To delete audio from a slide: 
1.	 Click the audio item in the timeline. (A)
2.	 Press the Delete key on your keyboard.

Delete Audio From a Slide

POWER TIP
You can use triggers to have more control over 
when your media plays.

Play/Pause/Stop Media Actions, p. 152

BRIGHT IDEAS

Tips for Working With Audio

The best way to get good quality audio is to start  
with the right recording environment.
•	 Use a unidirectional microphone with a foam 

windscreen. Unidirectional means it tries to pick 
up what’s coming from your mouth but not what’s 
coming from anywhere else around you. The 
windscreen helps reduce popping noises from  
“high breath” sounds such as “p” and “f.”

•	 To avoid echo, record in a room with soft surfaces, 
if possible. A carpeted room with curtains would be 
better than a tiled room with large glass windows.

•	 To reduce static and hissing, avoid interference 
from air conditioners, fluorescent lights, and 
electronic equipment.

•	 If you have to re-record any of your audio, try to 
use the same recording environment, if possible. 

•	 Don’t record audio if you are congested. If you 
have to go back and record edits later when you 
are feeling better, it may be impossible to match 
the tone you had earlier.

•	 If you need to edit your audio, you can use the 
audio editor, or you can export it, edit it in third-
party software (which may have more advanced 
editing features), and then import the new 
version. 

•	 If you edit your audio, be sure to check the timing 
of your on-screen elements. The timing may not 
match anymore.

B

A
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To edit audio:
1.	 Double-click the audio in the timeline.
2.	 Make the changes you want. (See next page.)
3.	 Click the Save & Close button.

Edit Audio

The Audio Editor

Working in the Audio Editor
•	 Click in the waveform to move the playhead. 
•	 Click the Play button to play from the location of the 

playhead.
•	 Click and drag your mouse across the waveform to 

select a section of audio.
•	 Click the Show All button to zoom the waveform to 

view all the audio at once.
•	 Click the Zoom Selection button to zoom in to show 

only the selected audio.

TIME SAVER
Press the Space bar on your keyboard 
to toggle between play and pause.

Zoom controls

Playhead

Record | Play | Stop

Waveform
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To delete a section of audio:
1.	 Click and drag your mouse to select the part you want 

to delete.
2.	 Click the Delete button. 
——— or ———
1.	 Click and drag your mouse to select the part you want 

to keep.
2.	 Click the Crop button.

To adjust the volume:
1.	 Select the section of audio you want to change.
2.	 Click the Volume button.
3.	 Click and drag the slider left (softer) or right (louder).
4.	 Click the OK button.

To insert silence:
1.	 Click in the waveform where you want to insert silence.
2.	 Click the Silence button.
3.	 Enter the number of seconds of silence you want to 

add.
4.	 Click the OK button.

To record new audio:
1.	 Click in the waveform where you want the audio to 

start or select the section you want the new audio to 
replace.

2.	 Click the Record button in the Audio Editor.
3.	 Click the Record button in the Record Microphone 

dialog box.
4.	 Speak into the microphone.
5.	 Click the Stop button.
6.	 Click the Save button.

To import new audio:
1.	 Click in the waveform where you want the audio to 

start or select the section you want the new audio to 
replace.

2.	 Click the Import button in the Audio Editor.
3.	 Find and select the file you want to import.
4.	 Click the Open button.

To cut or copy and paste audio:
1.	 Select the section you want to cut or copy.
2.	 Click the Cut or the Copy button.
3.	 Click in the waveform where you want to paste the 

audio, or select the section of audio you want to 
replace with the pasted audio.

4.	 Click the Paste button.

Audio Editing Options
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The Audio Tools: Options tab, which is available 
when the audio is selected in the timeline, provides 
some of the same options as the audio editor, along 
with a few additional options.

To change volume for the selected audio:
1.	 Click the Audio Volume drop-down button.
2.	 Select the volume level you want.

To replace the current audio with a different file:
1.	 Click the Change Audio button.
2.	 Find and select the file you want to use.
3.	 Click the Open button.

To export the selected audio:
1.	 Click the Export Audio button.
2.	 Navigate to where you want to save the file.
3.	 Enter a name for the file.
4.	 Click the Save button.

You can save the file as .wav, .mp3, or both.

The Audio Options dialog box, which you can access 
from the Audio drop-down button, gives you options 
that affect the entire project.

•	 Audio Playback: Default device: Select 
which output device you want to use to listen 
to the audio playback.

•	 Audio Recording: Default device: Select which 
recording device you want to use when you record. 
For example, you could select your computer’s built-in 
microphone or one that you plug in.

•	 Recording line: The recording line is for recording 
sounds that your computer makes. Use the volume 
slider to change the volume.

Audio Tools

TIME SAVER
Double-click the speaker icon that appears 
to the bottom left of the slide to preview the 
audio. Right-click the icon to access many of 
the same features as are on the Sound Tools 
tab. Note that if you delete this icon, you 
delete the audio as well.
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To import a closed caption file:
1.	 Select the audio or video file you want.
2.	 Go to the Options tab.
3.	 Click the Import button. 
4.	 Find and select the caption file you want to use.
5.	 Click the Open button. 

To replace a closed caption file:
1.	 Select the audio or video file you want.
2.	 Go to the Options tab.
3.	 Click the Import button. 
4.	 Find and select the caption file you want to use.
5.	 Click the Open button. 

To delete a closed caption file:
1.	 Select the audio or video file you want.
2.	 Go to the Options tab.
3.	 Click the Delete button. 

To export a closed caption file:
1.	 Go to the Options tab.
2.	 Click the Export button. 
3.	 Designate a name and location for the file.
4.	 Click the Save button. 

Import and Manage a Closed Caption File

Closed Captioning
Articulate Storyline lets you add closed captioning to audio and video files. When you attach a closed caption file to 
a slide, a button appears in the player (A) that lets the learner toggle the synchronized captions on and off. There 
are two ways to add captions:

•	 Create/import a caption file. Storyline accepts these industry-standard formats: SRT, VTT, SBV and SUB. These 
are text files that include the text for each caption and the time stamps for when it should appear.

•	 Manually create your own captions in Storyline.
The closed captions can be controlled by the student in the player. This is covered in chapter 14.
 

Example SBV caption file

Finished course with captions showing >>

Import/Replace Caption

Export Closed Captions

Delete Captions

Accessibility, p. 279

A
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Manually and Edit Create Closed Captions 
To manually create closed captions:

1.	 Select the audio or video file in the timeline.
2.	 Go to the Options tab.
3.	 Click the Add Captions button.
4.	 Click in a caption placeholder, and paste your 

caption text for that section of audio.
5.	 Add, delete, and resize caption placeholders, 

as needed. (See below.)
6.	 Click the Save & Close button.

To edit captions:
1.	 Select the audio or video file in the timeline.
2.	 Go to the Options tab.
3.	 Click the Edit Captions button.
4.	 Make your changes.
5.	 Click Save & Close button.

Options
The player controls (A) let you play and pause the 
audio and quickly jump to the next and previous 
captions.
The Insert Caption button (B) lets you manually 
insert a caption at the current playhead position.
The Delete Caption button (C) deletes the 
selected caption.
The Split Caption button (D) lets you split a 
single caption into two captions. This is useful 
for longer captions that take up too much 
space on screen.
The Import Captions button (E) lets you 
replace all the captions by importing a closed 
caption file such as .srt, .vtt, etc. 
The Export Captions button (F) lets you save 
your captions as a .vtt file. 
The Delete Captions button (G) deletes all the 
captions for the slide.
You can adjust the start time, end time, and length 
of a caption by clicking and dragging the right or 
left edge of the caption.

BA C D E

F

G



1118. Working With Media

Tips for Working With Closed Captioning

BRIGHT IDEAS
How do you get a caption file to import? 
•	 Create and export captions from free services such 

as YouTube or Amara.
•	 Use a professional captioning service such as 

3PlayMedia.
•	 Manually creating your caption files outside 

of Storyline can be helpful if you have team 
members who can help but who don’t have a 
Storyline license.

•	 Manually create your own file in Notepad using the 
exact same formatting as the example shown here. 
After you save it, change the file extension from 
.txt to .sbv.

CAUTIONS
•	 If you are going to use closed captions, design 

your slides so that there is nothing critical in the 
space where the closed captioning will appear.

•	 Captions cannot be added to videos from a 
website or Flash movies. SWF files can have 
captions if you add them as a video instead of as 
a Flash movie.

•	 If your caption file includes formatting tags, 
then any bolding, underlining, and italics will be 
supported. Any other formatting tags, such as 
font or color, will be ignored. You can adjust the 
font in the Player dialog box.

TIME SAVER
When you import an audio or video file that 
has a corresponding caption file, Storyline 
will automatically import both when you 
add the video file. This works if both files 
are in the same location and have the exact 
same name.

If you add audio to a marker, you can’t select it to 
get an Options tab. If you right-click the marker 
and select Accessibility, you can add audio or 
video captions in a dialog box. 
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To import video to a slide:
1.	 Go to the Insert tab.
2.	 Click the Video drop-down button.
3.	 Select Video from File.
4.	 Find and select the file you want.
5.	 Click the Open button.

Import Video to a Slide

Working With Video
As with audio, you can either import video or record it from within Storyline (if you 
have a webcam or other video camera attached to your computer). In addition, you 
can add a video from a website such as YouTube.

Video File Types

.3g2  	 .m1v	 .mpeg

.3gp  	 .m2v	 .mpg

.asf  	 .m4v	 .qt

.avi   	 .mov	 .swf 

.dv   	 .mp4	 .wmv 

.flv      .mpe

BRIGHT IDEAS
•	 You can search for free videos in the content 

library.

Content Library, p. 61

•	 If you import a PowerPoint slide that has video 
(added from either the PowerPoint Insert 
menu or from Articulate Presenter), the video is 
imported, appears on the Storyline timeline, and 
works like any other video.

•	 If you import an Engage file that contains video, 
the video plays in Storyline as well; however, like 
the rest of the Engage interaction, it cannot be 
edited in Storyline.

•	 Videos can be moved and resized just like 
graphics can.

Import a Slide, p. 31
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If you have a webcam or video camera attached to 
your computer, you can record video from within 
Storyline.

To record video in Storyline:
1.	 Go to the Insert tab.
2.	 Click the Video drop-down button.
3.	 Select Record Webcam.
4.	 Click the Record button. 
5.	 Do whatever you plan to record.
6.	 Click the Stop button. 
7.	 Click the OK button.

Click the Show device settings link for the following 
options:

•	 Video Device: Storyline automatically searches 
for a webcam on your computer. If one is not 
found, a No Signal message is displayed. If this 
happens, use this drop-down menu to select your 
webcam. You can also use this menu if you want 
to use a different webcam than the one that was 
automatically selected. 

•	 Advanced: This link gives you access to any 
webcam management software that you might 
have on your system. It allows you to adjust the 
color, brightness, contrast, special effects, etc., 
independent of the Storyline settings.

•	 Video Size: This drop-down menu gives you 
options for the pixel size of the video to be 
captured, based on the settings available for your 
camera.

•	 Audio Device: From this drop-down menu, you 
can select which audio device is used to record 
audio in conjunction with the video. In most cases, 
there will be an audio option for your web camera.

Record Video in Storyline
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Imagnisto iunt modita vitas

BRIGHT IDEA
How do you find the embed code? Here are the methods for two popular video-sharing sites (at the time of 
publication).

YouTube
1.	 Click the Share button below the video.
2.	 Click the Embed button.
3.	 Copy the code that appears below the video.

Vimeo
1.	 Hover your mouse over the video.
2.	 Click the Share icon.
3.	 Copy the embed code in the pop-up window.

Embed a Video From a Website
You can add video to your slides from popular video 
sharing websites such as YouTube, Vimeo, or any other 
website that provides an embed code.

To embed a video from a website:
1.	 Go to the web page with the video you want to 

embed.
2.	 Find and copy the embed code. (See below.)
3.	 In Storyline, go to the Insert tab.
4.	 Click the Video drop-down button.
5.	 Select Video from Website.
6.	 Paste the embed code in the space provided.
7.	 Click the OK button.
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When you import or record video on your slide, it appears 
wherever the playhead is in the timeline. (A) If you want to 
change the starting point of the video, simply click and drag 
the video item left (earlier) or right (later) in the timeline.
If you shorten the length of the video in the timeline (either 
by adjusting the start or the end time), it cuts off the end 
of the video. For example, if you shorten the video by two 
seconds, two seconds are cut off from the end.

To delete video from a slide: 
1.	 Click the video item in the timeline.
2.	 Press the Delete key on your keyboard.

Adjust Timing of Video

Delete Video From a Slide

POWER TIP
You can use triggers to have more control 
over when your media plays.

Play/Pause/Stop Media Actions, p. 152

A
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To edit video:
1.	 Select the video in the timeline or on the slide.
2.	 Go to the Options tab.
3.	 Click the Edit Video button.
4.	 Make the changes you want. (See next page.)
5.	 Click the Save & Close button.

Edit Video

The Video Editor

Timeline zoom 
controls

Playhead

Play | Stop

Preview

Timeline

Working in the Video Editor
•	 Click in the timeline to move the playhead.
•	 Click the Play button to play from the playhead.
•	 To fast-forward through the video, drag the playhead indicator along the timeline.
•	 To zoom in or out of the video timeline, click and drag the zoom slider. This slider does not change the size 

of the video. Instead, it provides more or less detail on the timeline. Zoom in for precise placement of trim 
points, logos, etc.
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Arum, iur sam vent optatur
From the Video Editor:
To trim off the beginning or end of the video:

1.	 Click the Trim button.
2.	 Click and drag the edge of the blue shaded area 

on the left side of the timeline to where you want 
the published video to begin. (A)

3.	 Click and drag the edge of the blue shaded area 
on the right side of the timeline to where you 
want the published video to end. (B)

4.	 Click the Save & Close button.

To crop a video:
1.	 Click the Crop button.
2.	 Click and drag the corner handles to outline the 

area you want to include in your video. (C)
3.	 Click and drag the middle of the crop box to 

move it around.
4.	 Click the Save & Close button.

To change the volume of the video:
1.	 Click the Volume button.
2.	 Click and drag the slider left (lower volume) or 

right (higher volume).
3.	 Click the OK button.

Note that the volume changes will only be heard when 
your project is published.

To change the brightness of the video:
1.	 In the Brightness field, enter a positive number 

(brighter) or negative number (darker) from -100 
to 100.

To change the contrast of the video:
1.	 In the Contrast field, enter a positive number 

(more contrast) or negative number (less 
contrast) from -100 to 100.

Video Editing Options

BRIGHT IDEAS
•	 The full video stays on the timeline, so you 

can make changes to the trim or crop at 
any time.

•	 If you don’t want the trim or crop after 
all, click the Trim or Crop button again to 
remove the settings. The settings are saved 
if you ever decide to activate them again.

DESIGN TIPS
•	 A small increase in brightness and contrast 

can help most “homemade” movies look 
sharper.

•	 In addition to using brightness and 
contrast for image correction, you can also 
use them for artistic effects. For example, 
an opening clip with full brightness and 
full contrast might create interesting color 
effects.

Not 
included Included

A

B

C
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Imagnisto iunt modita vitas
To add a logo to the video:

1.	 Click the Insert Logo button.
2.	 Find and select the image you want.
3.	 Click the Open button.
4.	 Click and drag the corner handles to resize the image.
5.	 Click and drag the image to reposition it.

Options
•	 You can remove the logo by clicking the Remove 

Logo button.
•	 You can create a watermarked logo by adjusting the 

transparency in the Transparency field.

To replace the current video with a new file:
1.	 Click the Change Video button.
2.	 Find and select the video file you want.
3.	 Click the Open button.

To reset the video to its original settings:
1.	 Click the Reset Video button.

Video Editing Options (cont’d)
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The Video Tools: Options tab is available when the 
video is selected.

To change volume for the video:
1.	 Click the Video Volume drop-down button.
2.	 Select the volume level you want.

Video Options
By default, the video plays on the slide, starts 
automatically, has no playbar or controls, and is 
automatically compressed. You can change any of 
these settings on the Options tab.

To open the video in a new browser window:
1.	 Click the Show Video drop-down menu.
2.	 Select In new browser window.

When you select this option, a thumbnail of the video 
stays on the slide. (A) When the student clicks the 
thumbnail, a new browser window opens that plays 
the video.

To play the video when clicked:
1.	 Click the Play Video drop-down menu.
2.	 Select When clicked.

When you select this option, the video plays 
independently from the timeline. The thumbnail 
appears when the timeline reaches the video 
object, but does not play until the student clicks it.

To play the video based on a custom trigger:
1.	 Click the Play Video menu.
2.	 Select When triggered.
3.	 Manually add a trigger using the Play Media 

action to control the video.

Video Tools

A

BRIGHT IDEA
You can also use triggers to pause, and 
stop your video. 

Media actions, p. 152
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Show Video Controls
Select this option if you want to add a control 
toolbar that lets the student play and pause the 
video. (B)

Compression
By default, Storyline will compress the video when you 
publish the course. Select None to turn off automatic 
compression. This will maintain the video’s file type, 
size, and resolution when published. This option is only 
available with .mp4 videos.

Quality Settings, p. 259

Alt Text
To make your course accessible to students with visual 
impairments using a screen reader, you can add alt text 
to your video. The screen reader will read the text in 
this field out loud to the student. 

To add alt text to video:
1.	 Select the video.
2.	 Right-click the video.
3.	 Select Accessibility.
4.	 Type in Alternate text field. (C)
5.	 Click the Close button. (D)

Accessibility, p. 279

Captions
Just as with audio, you can add closed captioning to 
your video.

Closed Captioning, p. 109

Video Tools (cont’d)

B

C

D
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To insert a web object:
1.	 Go to the Insert tab.
2.	 Click the Web Object button.
3.	 Type the web address in the Address field.
4.	 Select the options you want. (See below.)
5.	 Click the OK button.

Options
Display

•	 Display in slide: This option, selected by default, 
embeds the web page into the slide, as described 
above.

•	 Display in a new browser window: Select this 
option if you would rather have the web page open 
in its own window. 

•	 Browser Controls and Window Size: These 
options are available if you choose to display the 
web object in a new browser window. You can learn 
more about these options in chapter 10.

Behavior
•	 Load web object automatically: If you leave 

this selected, the web object is active as soon as it 
appears on the timeline. If you uncheck this option, 
the web object appears as a thumbnail that the 
student must click to activate the page.

Insert a Web Object

Web Objects
You can use the Web Object feature to insert a functional 
web page into your course. While a hyperlink takes the 
student to a web page outside the course, a web object 
embeds the page into the course itself. This lets the 
student interact with the web page without ever leaving 
the course.

Google Docs survey embedded 
on a slide as a web object

DESIGN TIP
Displaying a web object in a new window 
is similar to the Jump to URL/File action. 
With a web object, the link opens when the 
object is reached in the timeline. With the 
action, the link opens when the action is 
triggered (such as from clicking a button).

Jump to URL/File trigger, p. 154
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The Web Object Tools: Options tab (which is 
available when the web object is selected) provides 
some of the same options as when you initially set 
up the web object, as well as some of the arranging 
options available for most objects.

Preview
Click the Preview button to see what the live web 
object will look like. Click the button again to return 
to edit mode.

Open
Click this button to open the webpage in a new 
browser window.

Edit
Click this button to bring up the same dialog box that 
appeared when you added the web object. (See previous 
page.)

Display and Browser
These two sections let you change the settings you 
made when you first inserted the web object.

Arrange and Size
Use these tools to position the web object on the 
slide.

Web Object Tools

POWER TIP
You can also use a web object to display a 
webpage stored locally on your computer 
or a shared drive, even if it isn’t accessible 
from a network. 
Instead of typing in a web address, click the 
Browse button and locate the index.htm 
or index.html file for the webpage you 
want to insert.
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To insert a Flash file:
1.	 Go to the Insert tab.
2.	 Click the Video button.
3.	 Select Flash Movie.
4.	 Find and select the file you want.
5.	 Click the Open button.

Insert a Flash File

Adding Flash Files
Flash files include an animation or interaction created in Adobe Flash or any number of other software packages 
that publish to Flash, such as Raptivity or Captivate. These files have an extension of .swf.
Once inserted, Flash files play much like video files: you can have them play automatically with the timeline or use 
the Options tab to play them in a separate window, play when the student clicks them, etc.

CAUTION
If you add a Flash movie file (.flv) to your 
project, it will be converted to an HTML5 
format when you publish. If you add a 
Flash .swf file, it will NOT be convered to an 
HTML5 format. Because of this, .swf files 
will not play on an iPad or iPhone.
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Notes


